
© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

 

 

 

 

 

 

       Product Guide 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

Contents 

1. Introduction .................................................................................................................................................................... 5 

1.1 Using the guide ....................................................................................................................................................... 5 

1.2 Recoveryfix for Outlook PST Repair ...................................................................................................................... 6 

1.4 Who should use this Software? ............................................................................................................................... 7 

2. Getting Started ................................................................................................................................................................ 8 

2.1 Installation Pre-requisites ........................................................................................................................................ 8 

2.2 Downloading Recoveryfix for Outlook PST Repair for the First Time .................................................................. 9 

2.3 Install Recoveryfix for Outlook PST Repair ........................................................................................................... 9 

2.4 Run Recoveryfix for Outlook PST Repair .............................................................................................................. 9 

2.5 Uninstall Recoveryfix for Outlook PST Repair ...................................................................................................... 9 

3. Software Interface ......................................................................................................................................................... 11 

3.1 Main Menu ............................................................................................................................................................ 11 

3.2 Tool bar ................................................................................................................................................................. 12 

3.3 Left Panel .............................................................................................................................................................. 13 

3.4 Right Panel ............................................................................................................................................................ 14 

4. Using Recoveryfix for Outlook PST Repair ................................................................................................................. 15 

4.1 Standard Mode ...................................................................................................................................................... 15 

4.2      Advance Mode ....................................................................................................................................................... 19 

5. Saving Options .............................................................................................................................................................. 22 

5.1 Save In Outlook .................................................................................................................................................... 22 

5.2       Save in Outlook Express ....................................................................................................................................... 25 

6. Licensed Version .............................................................................................................................................................. 27 

6.1      Requirement of Licensed Version .......................................................................................................................... 27 

6.2      Purchasing Licensed Version ................................................................................................................................. 27 

7. Support .......................................................................................................................................................................... 28 

8. Troubleshooting ............................................................................................................................................................ 29 

8.1 Frequently Asked Questions (FAQs) .......................................................................................................................... 29 

9. Legal Notices ................................................................................................................................................................ 30 

9.1 Copyright .............................................................................................................................................................. 30 

9.2 Trademark ............................................................................................................................................................. 30 

9.3 Disclaimer ............................................................................................................................................................. 30 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

9.4 License Agreement ............................................................................................................................................... 31 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

Figures 

Figure 3.1: File Menu ........................................................................................................................................................... 11 

Figure 3.2: Help Menu .......................................................................................................................................................... 12 

Figure 3.3: Left Panel ........................................................................................................................................................... 13 

Figure 3.4: Right Panel ......................................................................................................................................................... 14 

Figure 4.1: Welcome Screen ................................................................................................................................................. 15 

Figure 4.2: Select PST File ................................................................................................................................................... 16 

Figure 4.3: Selected PST file enlisted ................................................................................................................................... 16 

Figure 4.4: Scanning Process dialog ..................................................................................................................................... 17 

Figure 4.5: Left Panel ........................................................................................................................................................... 17 

Figure 4.6: Preview Window (Right Panel – Display & Preview Panel) ............................................................................. 18 

Figure 4.9: Saving Process dialog ......................................................................................................................................... 19 

Figure 4.10: Saved Files........................................................................................................................................................ 19 

Figure 4.11: Welcome Screen ............................................................................................................................................... 20 

Figure 4.12: Right Panel ....................................................................................................................................................... 21 

Figure 5.1: Saving Options Window ..................................................................................................................................... 22 

Figure 5.2: Saving Process .................................................................................................................................................... 24 

Figure 5.3: Saved Files dialog............................................................................................................................................... 24 

Figure 5.4: Saved Files dialog............................................................................................................................................... 25 

 

 

 

 

 

 

 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

1. Introduction 

Welcome to the user guide for Recoveryfix for Outlook PST Repair software, one of the most advanced 
and efficient PST recovery software available today. It quickly repairs severely corrupt, damaged, 
inaccessible, or deleted PST files, and accurately recover all mailbox data items including emails, 
attachments, contacts, appointments, notes, tasks, journals, sent items, calendars etc. without making any 
data loss. The software also provides multiple saving options to save the recovered data items. The 
software is equipped with user-friendly graphical interface and self-explained features.  

 

1.1 Using the guide 

The user manual is aimed to guide the users who are looking for a reliable solution to recover corrupt PST 
files, by describing the complete working of Recoveryfix for Outlook PST Repair software. First time users 
are recommended to read all the points of user manual carefully before using the software. However, 
experienced users can use the table of contents to get the required information. The table of contents lists 
all the sections of the guide in sequential order.  

The user manual includes the following sections:    

 Introduction 

 Getting Started 

 Software Interface 

 Using Recoveryfix for Outlook PST Repair 

 Saving Options 

 Licensed Version 

 Support 

 Troubleshooting 

 Legal Notice 

Please go through the list of abbreviations used in the guide mentioned below: 

1.1.1 List of Abbreviations  

 PST or .PST: Personal Storage Files (MS Outlook) 

 EML or .EML: Electronic Mail (Outlook Express) 

 MSG or .MSG: File format supported by MS Outlook and Exchange Server 

 QFSCI: Quick File System Component Identification 

 MS: Microsoft 
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 RAM: Random Access Memory 

 MB: Mega-Byte 

 GB: Giga-Byte 

 

1.2 Recoveryfix for Outlook PST Repair 

Recoveryfix for Outlook PST Repair has been programmed to make quick and accurate PST file recovery 
when PST file gets corrupted, damaged, inaccessible or deleted. The software is integrated with various 
advanced data recovery features that help in recovering corrupt PST files in almost every condition. The 
software is capable of fixing any PST corruption issue including Exchange Server failure, Virus attacks, 
Hard drive failure, Registry errors, Abrupt system shutdown, Outlook crash etc.  

For complete and accurate recovery of corrupt PST files, the software offers dual recovery mode – 
Standard Mode and Advanced Mode. The two modes allow you to perform quick scanning to locate 
corrupt PST files, repair them and recover the data stored in them.  

Recoveryfix for Outlook PST Repair software efficiently recovers all mailbox items such as Emails, 
Attachments, Contacts, Notes, Scheduled tasks, Appointments, Calendar items, Tasks, Journal, Drafts, 
Deleted Items folders etc. from corrupt or inaccessible PST files. The software is incorporated with 
advanced QFSCI algorithms, which help in preserving the properties, formatting, and Meta data of emails, 
which include information like From, To, Subject, CC, BCC, Date and Time.  

Recoveryfix for Outlook PST Repair tool offers multiple saving options to save recovered PST files. You 
can save the recovered data in PST (MS Outlook), MSG (MS Outlook), OE Store and EML (Outlook 
Express, Thunderbird etc.) format. 

 

1.3 Prominent Features 

Recoveryfix for Outlook PST Repair is an easy-to-use software, and you can easily operate it without 
having any technical knowledge. Its self-explained features make it even better. Some outstanding 
features of the software are mentioned below:  

 Repairs PST files corrupted due to issues like Exchange Server failure, Outlook crash, virus 
attacks etc.  

 Embedded with two recovery modes – Standard Mode and Advanced Mode for quick and accurate 
PST recovery 

 Recovers all mailbox data items including emails, contacts, appointments, tasks, notes, calendar, 
journals, drafts, deleted emails etc. 

 Capable of recovering attachments, zipped attachments, and images from corrupt or inaccessible 
PST files 

 Proficiently recovers emails from highly encrypted, password protected and permanently or 
accidentally deleted PST files 
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 Preserves Meta data of emails (From, To, CC, BCC, Subject, Date and Time) 

 Option to save recovered PST data in various file formats such as PST, MSG, and EML 

 Offers advanced email filtering options for refined segregation of email items on the basis of date-
range  

 Retains original formatting, properties, and structure of PST files after recovery 

 Provides ‘Find’ option to locate or search corrupt PST files 

 Option to preview all recovered items before saving them at desired location 

 Offers 30 day money-back guarantee 

 Available in free trial version 

 

1.4 Who should use this Software? 

Recoveryfix for Outlook PST Repair is an advanced and intelligently programmed PST recovery software. 
Its data recovery capabilities have made it a preferred choice among individuals and organizations across 
the world. Especially, system administrators working for organizations find it very useful.  
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2. Getting Started 

Now, you have the introductory knowledge about Recoveryfix for Outlook PST Repair software. To get the 
hands-on experience, you need to download and install the software. You’re advised to check the 
minimum system requirements before installing the software. Also, ensure that your system is properly 
configured to run the software before installation.  

 

2.1 Installation Pre-requisites 

There are specific hardware and software requirements before installing the software.  

2.1.1 Hardware Requirements: 

There are certain hardware requirements that your computer system needs to fulfill before the software 

installation. The requirements are: 

 Pentium Class Processor 

 Minimum 512 MB RAM 

 10MB Free Disk Space for Software installation 

 Enough Free Disk Space to store the recovered files 

 You should have at least 10 MB free disk space if you want to repair and save a 10 
MB .PST file. 

2.1.2 Software Requirements: 

The software requirements for installing the software can be divided further in two categories – Operating 
system requirements and applications version requirements. 

2.1.2.1 Operating System Requirements 

The software can easily be installed on any of the Windows versions available.  

Supported Operating Systems (both 32 and 64 bits): 

Windows 8.1, Windows 8, Windows 7, Windows Vista, Windows XP, Windows 2003, Windows 2000 

2.1.2.2 Supported Application Platforms 

Supported MS Outlook versions:  

Microsoft Outlook 2013 (both 32 and 64 bits), 2010, 2007, 2003, 2002, 2000, 98 and 97   

 Note: Microsoft Outlook should be installed and correctly configured before using 

the software. 
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2.2 Downloading Recoveryfix for Outlook PST Repair for the First 
Time 

So, after checking minimum system requirements for Recoveryfix for Outlook PST Repair installation, you 
can download and install the software on your computer system. You can purchase the software through 
one of our authorized resellers – Element5 or Avangate.  

You can even run the software without buying it. Just download the free evaluation version of the software 
and use it. Link to download the evaluation version is given below: 

http://www.outlookpstrepair.recoveryfix.com/ 

 The evaluation version of Recoveryfix for Outlook PST Repair tool allows you to 
recover and preview PST data, but restricts you from saving more than 25 email 
items per folder. To save all recovered items, you need to purchase the licensed/full 
version of the software.  

 

2.3 Install Recoveryfix for Outlook PST Repair 

After downloading the installer or .exe file from the above-mentioned link, you can install the software by 
double-clicking the .exe file. 

Perform the following steps to install the software: 

1. Double-click the installer file .exe file of Recoveryfix for Outlook PST Repair software 

2. Keep following the on-screen instructions until the installation process gets over. “Completing the 
Recoveryfix for Outlook PST Repair Setup Wizard” message appears on the software 
installation screen 

3. Click the Finish button to complete the software installation and launch the software 

 

2.4 Run Recoveryfix for Outlook PST Repair  

After installation, you can simply launch the software by double-clicking the shortcut icon of the software 
on desktop and Quick Launch icon. You can also launch the software by clicking Start  All Programs  
Recoveryfix for Outlook PST Repair  Recoveryfix for Outlook PST Repair. 

 

2.5 Uninstall Recoveryfix for Outlook PST Repair 

If you need to uninstall the software, you can do it either from Windows Start Menu or from the Control 
Panel.  

 

http://www.outlookpstrepair.recoveryfix.com/
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Uninstall from Windows Start menu 

1. Click Start  All Programs  Recoveryfix for Outlook PST Repair  Uninstall Recoveryfix for 
Outlook PST Repair (A warning message will be displayed) 

2. Click Yes to uninstall.  

 Make sure that the software is not running before you begin the uninstallation 
process.  

Uninstall from Control Panel 

You can also uninstall the software from Control Panel by performing the following steps: 

1. Click Start Menu  Control Panel  

2. Double-click Add or Remove Programs icon 

3. Select Recoveryfix for Outlook PST Repair and click Remove 

As soon as you click on Remove, a warning message will be displayed. 

4. Click Yes to uninstall  

You’ve successfully uninstalled the Recoveryfix for Outlook PST Repair software. 
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3. Software Interface 

After successful installation of the software, you can start using it. However, before you start using 
Recoveryfix for Outlook for PST Repair software, you must know about its interface.  

 

3.1 Main Menu 

The main menu of the software has two menus, which are further divided into several menu items. The 
main menu includes:  

 File Menu  

 Help Menu 

 

3.1.1 File Menu 

The File menu comprises of three menu items.  

 

          
 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Next To go to the next step 

Back Takes you to the previous step 

Exit Closes Recoveryfix for Outlook PST Repair software 
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3.1.2 Help Menu 

The Help menu includes three items: 

    

 
Figure 3.2: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

About Displays version and support related information about 
the software 

Help Displays User’s Help Manual for Recoveryfix for Outlook 
PST Repair 

Software Homepage Takes you to the official website page of the software 

3.2 Tool bar 

Tool bar is placed right below the main menu. It has the following buttons: 

 

Button Button Name Description 

 

Next To move to the next step 

              

Back 
To go back to the previous 

step  
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Stop 
To stop/pause the recovery 

process  

 

Help 
Displays User’s Help Manual 
for Recoveryfix for Outlook 

PST Repair 

 
Buy Now 

Navigates to the online 
purchase portal of the  

software 

 

3.3 Left Panel 

Left Panel of Recoveryfix for Outlook PST software displays the recovered PST files and folders in a 
hierarchical order. You can go through all recovered files and folders. Left Panel displays the recovered 
data as shown in the screenshot given below:  

 

  

Figure 3.3: Left Panel 
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3.4 Right Panel 

Right Panel of Recoveryfix for Outlook PST Repair software displays all email items of the file or folder 
selected in the Left Panel.  

As you can see in the image given below, Right Panel is further divided into two panels – Display Panel 
and Preview Panel. The portion (upper-half) in which all email items are enlisted is the Display Panel and, 
the below half where content of a specific email item is displayed is the Preview Panel. 

            

Figure 3.4: Right Panel 

Display Panel – Shows all email items of the file for folder selected in the Left Panel. 

Preview Panel – Shows preview of content of email items selected in the Display Panel.  
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4. Using Recoveryfix for Outlook PST Repair 

Recoveryfix for Outlook PST Repair performs flawless recovery of inaccessible or damaged PST files and 
allows you to save them in different formats such as PST, MSG, and EML. You can view these recovered 
email items in various email applications other than MS Outlook and Outlook Express. 

 

4.1 Standard Mode 

Using Recoveryfix for Outlook PST Repair, you can efficiently repair and recover corrupt or inaccessible 
PST files. The software creates a new PST file to save the recovered data at a user-defined location. 
Below given are the steps to repair and recover PST files using Recoveryfix for Outlook PST Repair 
software:  

1. Click Start > All Programs > Recoveryfix for Outlook PST Repair > Recoveryfix for Outlook PST 
Repair to launch the software. The main window or welcome screen of the software appears: 

 

 

Figure 4.1: Welcome Screen 

2. Click the Browse button and select the PST file, if you already know the location of PST file.  
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Figure 4.2: Select PST File 

3. Select the file and click Open or double-click the file to add it to the software’s interface. The software 
will enlist the selected PST file.  

 

Figure 4.3: Selected PST File Enlisted 
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4. Select the adequate mode button, and then click Next to start the scanning process. Select Standard 
mode for example. 

 
 

Figure 4.4: Scanning Process dialog  

5. Once the scanning process gets over, the software displays the recovered PST file and all email items 
in the hierarchical tree-like structure in its Left Panel.  

 

Figure 4.5: Left Panel 

6. Select the desired PST file or folder from the Left Panel to view its content in the Right Panel.  



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

 
 

Figure 4.6: Preview Window (Right Panel – Display & Preview Panel) 

7. After previewing content of desired file (s) or folder (s), select the file and items you want to save from 
the Left Panel by clicking its checkbox and click Next.  

8. In the Saving Options window, click Save In Outlook option to save the recovered PST files in PST or 

MSG format or else click Save in Outlook Express option to save the recovered PST files in OE 

Store and EML format.  

9. After selecting desired saving option, click the Browse button to select the saving location. If you save 
the recovered PST file in PST format, you get other options like Split Option, Remove “Top of 
Personal Folder” from hierarchy in Outlook/Outlook express, and Attach Prefix To Store Name.  

10. Configure all the required options, and then click OK to complete the saving process.  
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Figure 4.9: Saving Process Dialog 

11. After the saving process gets over, the software displays the following message: 

 

Figure 4.10: Saved Files 

12. Click OK to finish the process. You can open the link given to see the recovered PST files.  

 

4.2 Advance Mode  

Advance Mode is programmed to deal with severely corrupt PST files. When Standard mode fails to 
provide desired results, select Advanced mode and perform the recovery process. Advance mode takes 
its time but at the end ensures complete and accurate recovery of PST file. To perform the recovery 
process using Advance mode, see the steps given below: 

1. Click Start > All Programs > Recoveryfix for Outlook PST Repair > Recoveryfix for Outlook PST 
Repair to launch the software. The main window or welcome screen of the software appears. 

2. Click the Browse button and select the PST file, if you already know the location of PST file. 

3. Select Advance mode and click the Next button to start the scanning process. 
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Figure 4.11: Welcome Screen  

 

4. Once the scanning process gets over, the software displays the recovered PST file and all email items 
in the hierarchical tree-like structure in its Left Panel. 

5. Select the desired folder from the Left Panel to preview its content.  
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Figure 4.12: Right Panel 

 

6. After previewing, select the file and items you want to save from the Left Panel by clicking their 
checkbox and click the Next button. 

7. Saving Options window appears. Click Save In Outlook option to save the recovered PST files in 

PST or MSG format or else click Save in Outlook Express option to save the recovered PST files in 

OE Store and EML format.  

8. After selecting desired saving option, click the Browse button to select the saving location. If you save 
the recovered PST file in PST format, you get other options like Split Option, Remove “Top of 
Personal Folder” from hierarchy in Outlook/Outlook express, and Attach Prefix To Store Name.  

9. Configure all the required options, and then click OK to begin the saving process.  

10. Once the saving process is over, the software displays the message. 

11. Click OK to finish the recovery process. Click the link given inside the dialog box to see the recovered 
PST files.  
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5. Saving Options 

Now, you’ve learned the PST recovery process of Recoveryfix for Outlook PST Repair software. Let’s learn 
about the saving options offered by the software to save the recovered PST files. The software majorly offers 
two saving options – Save In Outlook and Save in Outlook Express. 

5.1 Save In Outlook  

Once you have efficiently retrieved PST email items by utilizing the processing power of Recoveryfix for 
PST Repair, saving recovered files is the final step in the PST recovery process. If you select Save In 
Outlook option, you can save the recovered data in PST or MSG file format.  

 PST File (MS Outlook): This option allows you to save the recovered email data in MS Outlook 
PST format.  

 MSG File (MS Outlook): This option allows you to save the recovered email data in MSG format, 
which is supported by MS Outlook.   

 

Figure 5.1: Saving Options Window 
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5.1.1 Save in PST 

1. Select the Save In Outlook option, and specify option Save in PST. 

2. Define the saving location, click the Browse button and select the desired storage location on your 
computer’s hard disk. 

3. The software provides you option to split the resultant PST file. You can use the split option if the 
repaired PST file is too large. Here are the various split options you can use: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. The software also provides option for adding prefix to the Store Name. Click “Attach Prefix to Store 
Name” option and type the required prefix in the Store name prefix text box. 

5. Select Remove “Top of Personal Folder” from hierarchy in Outlook to remove top of personal 
folder from the folder hierarchy successfully.  

6. Click OK to begin the saving process. 

Split Options Functions 

 Do not split file Select this option to create a single PST file to save data 

Split file after 1GB Select this option to split the PST file in equal 1GB files 

Split file after 1.5GB Select this option to split the PST  file  in equal 1.5GB 
files 

Split file after 2GB Select this option to split the PST file in equal 2GB files 

Split file after 2.5GB Select this option to split the PST file in equal 2.5GB 
files 

Split file after 3GB Select this option to split the PST file in equal 3GB files 

Split file after 3.5GB Select this option to split the PST file in equal 3.5GB 
files 

Split file after 4GB Select this option to split the PST file in equal 4GB files 

Split file after 5GB Select this option to split the PST file in equal 5GB files 
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Figure 5.2: Saving Process  

7. Once the saving process is over, the software displays the following message: 

 

Figure 5.3: Saved Files Dialog 

You can access the newly created PST file by clicking on the link given in the dialog box.  

       5.1.2 Save In MSG 

1. Select the Save In Outlook option, and to save the recovered PST data in MSG format, select Save in 
MSG option.  

2. Click the Browse button to specify the desired saving location. 

3. Click on Split Option, if you wish to split large-sized PST files into smaller chunks. 

4. Select Remove “Top of Personal Folder” from hierarchy in Outlook as per the requirement and 
click “OK” button.  

5. Once saving process gets over, the software displays the successful saving dialog box (as seen in the 
image 5.3 given above). 

6. Click OK to complete the saving process. 
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5.2 Save in Outlook Express  

The Recoveryfix for PST Repair software provides you an additional option to save files in the latest 
supported Outlook Express edition if you select Save In Outlook Express option, you can save the 
recovered data in OE Store or EML format.  

 OE Store (Outlook Express): This option lets you save the recovered PST files in OE Store, the 
store root directory that is saved on your system’s hard drive by default. Outlook Express uses it.  

 EML File (Outlook Express): This option lets you to save the recovered email data in EML format, 
which is supported by Outlook Express, Novell GroupWise, Windows Mail, Thunderbird, and 
Postbox.  

 

Figure 5.4: Saving Option Dialog Box 

5.2.1 Save In OE Store 

1. Select the Save In Outlook Express option, and select Save in OE Store option to save the recovered 

data in OE Store.  

2. Select Remove “Top of Personal Folder” from hierarchy in Outlook Express as per the 
requirement.  
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3. Browse the desired saving location and click OK to proceed. The software begins the saving process. 

4. Once the saving process gets over, the software displays the Saved Files dialog.  

5. Click OK to finish the saving process. The dialog box carries the location link where the recovered files 
are saved.  

6. Click on the link to access the recovered files.  

 By default, the OE Store (Store root directory) is saved on your system’s hard drive.  

 The default location of OE Store is: C:\Windows\Application Data\Outlook 
Express\{GUID} or C:\Documents and Settings\<User>\Local 
Settings\Application Data\Identities\{GUID}\Microsoft\Outlook Express 

 The location of OE Store might differ with the different versions of Operating System. 

5.2.2 Save In EML 

1. Select the Save In Outlook Express option, and to save the recovered data in EML file format, select 

Save in EML option.  

2. Click the Browse button to specify the saving location and click OK to start the saving process.  

3. After the saving process is completed, the software displays the Saved Files dialog. Click OK to finish 

the saving process.  

4. The dialog box carries the location link where the recovered files are saved and so, click on the link to 

access the recovered files. 

 EML format is supported by Outlook Express and various other email clients like 
Novell GroupWise, Windows Mail, Thunderbird, and Postbox. 
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6. Licensed Version 

Free evaluation of Recoveryfix for Outlook PST Repair software is available. You can use it free to check 
software’s functionality and data recovering capabilities. It allows you to recover and preview PST data 
free of cost. However, it has certain limitations. To use the software without limitations, you need to 
purchase its licensed or full version. You can purchase the software from its website page. Here is the link: 

http://www.outlookpstrepair.recoveryfix.com/ 

 

6.1 Requirement of Licensed Version 

Free evaluation version of the software allows you to recover all email items including emails, 
attachments, contacts, calendar items, sent items, drafts, tasks, appointments, notes, journals etc. from 
corrupt or inaccessible PST files and displays them in a hierarchical order. You can have a clear preview 
of every single item recovered before saving it at desired location. To save entire recovered PST data, 
licensed version or full version of Recoveryfix for Outlook PST Repair is required.  

 

6.2 Purchasing Licensed Version 

You can purchase the licensed version of Recoveryfix for Outlook PST Repair software from one of our 
authorized resellers – Element5 and Avangate. 

As soon as you finish the purchasing formalities, our sales team will send you an email having link to 
download the software and its activation details.  

 Within 15 minutes of completing buying formalities, you’ll receive an email with 
download link, activation key and other details related to the software. 

 

 

 

 

 

 

 

 

 

http://www.outlookpstrepair.recoveryfix.com/
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7. Support 

Recoveryfix for Outlook PST Repair software comes with 24*7 Tech support. Our extensive support team 
is always available to provide round-the-clock assistance to its customers. An embedded help manual also 
comes with the software. To access the help manual, click on HelpHelp (F1) in main menu on the 
welcome screen of the software. You can also press the F1 key to open the help manual directly. 

You can access the online help for Recoveryfix for Outlook PST Repair at  

Web Support:  

Online Support:  

You can also get the help of our experts online by visiting our support section. You can communicate 
directly to our experts online. 

http://www.recoveryfix.com/contact-us.html 

Telephone Support:  

Software Helpline:  

+91-9818725861 

Email Support:  

For Sales: sales@recoveryfix.com  

For Support: support@recoveryfix.com  
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8. Troubleshooting 

You might have general or specific questions related to the software before using it. Here are the answers 
to all of them. 

 

8.1 Frequently Asked Questions (FAQs) 

Q. What’s the procedure to buy Recoveryfix for Outlook PST Repair? 

Ans. You can purchase Recoveryfix for Outlook PST Repair software online. Simply click on the link given 
below and place the order. As soon as you finish the purchasing formalities, you’ll receive an email within 
15 minutes with link to download the software and activation details. 

http://www.nucleustechnologies.com/Buy-Microsoft-Outlook-Mails-Recovery-Software.php  

Q. I have lost the full version for Recoveryfix for Outlook PST Repair. What to do? 

Ans. Please email us at sales@nucleustechnologies.com including your name, address, email address, 
and order confirmation number (if you have it). Our support team will resolve your query as soon as 
possible. 

Q. I use Windows XP. Does the software support this version? 

Ans. Recoveryfix for Outlook PST Repair supports all versions of Windows OS including Windows 2000, 
2003, XP, Vista, 7, 8 and 8.1. You can even check the supported versions on the website page of the 
software - http://www.outlookpstrepair.recoveryfix.com/ 

Q. Why there are limitations with the evaluation copy of Recoveryfix for Outlook PST Repair 
software? 

Ans. The evaluation copy of the software is aimed to let you to check its functionalities and data recovery 
capabilities. It allows you to get friendly with the software’s features. Using trial or evaluation copy of 
Recoveryfix for Outlook PST Repair, you can recover and preview PST data. However, it restricts you 
from saving the recovered data, and that’s the only limitation it has. To save the recovered data, you need 
to purchase the licensed version of the software.  
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9. Legal Notices 

This section describes the legal specifications about Recoveryfix for Outlook PST Repair software and the 
company LEPIDE SOFTWARE PRIVATE LIMITED. 

 

9.1 Copyright 

LEPIDE SOFTWARE PRIVATE LIMITED, Lepide Software accompanied user manual and documentation 
are copyright of LEPIDE SOFTWARE PRIVATE LIMITED, with all rights reserved. Under the copyright 
laws, this user manual cannot be reproduced in any form without prior written permission of LEPIDE 
SOFTWARE PRIVATE LIMITED. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

© LEPIDE SOFTWARE PRIVATE LIMITED. All rights reserved. 

 

9.2 Trademark 

Recoveryfix ® is a copyright work of LEPIDE SOFTWARE PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, Windows 7, Windows 8, 
Windows 8.1, MS Outlook, Outlook Express, MS-DOS and Open Office are registered trademarks of 
Microsoft Corporation and Sun Microsystems Inc.  

All other brand and product names are trademarks or registered trademarks of their respective companies. 

 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. LEPIDE SOFTWARE PRIVATE LIMITED provides no warranty with regard to 
this manual or any other information contained herein and hereby expressly disclaims any implied 
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing. 
LEPIDE SOFTWARE PRIVATE LIMITED assumes no liability for any damages incurred directly or 
indirectly from any technical or typographical errors or omissions contained herein or for discrepancies 
between the product and the manual. In no event shall LEPIDE SOFTWARE PRIVATE LIMITED, be liable 
for any incidental, consequential special, or exemplary damages, whether based on tort, contract or 
otherwise, arising out of or in connection with this manual or any other information contained herein or the 
use there of. 
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9.4 License Agreement 

Recoveryfix for Outlook PST Repair Copyright © by LEPIDE SOFTWARE PRIVATE LIMITED 

Your Agreement to this License  

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by LEPIDE SOFTWARE PRIVATE 
LIMITED. The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Recoveryfix for Outlook PST Repair software. For purposes of this License, if you have a valid 
license, you have the right to use a single Licensed Copy of Recoveryfix.  

Scope of License 

Each Licensed Copy of Recoveryfix for Outlook PST Repair may either be used by a single person or 
used non-simultaneously by multiple users who use the software personally installed on a single 
workstation. All rights of any kind in Recoveryfix, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by LEPIDE SOFTWARE PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
nor permit anyone else to do so. You may not make access to Recoveryfix available to others in 
connection with a service bureau, application service provider, or similar business, nor permit anyone else 
to do so.   

Warranty Disclaimers and Liability Limitations 

Recoveryfix for Outlook PST Repair, and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Recoveryfix, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Recoveryfix covered by this License. This disclaimer of warranty constitutes an essential part of 
this License. In addition, in no event does LEPIDE SOFTWARE PRIVATE LIMITED authorize you or 
anyone else to use Recoveryfix for Outlook PST Repair in applications or systems where Recoveryfix for 
Outlook PST Repair failure to perform can reasonably be expected to result in a significant physical injury, 
or in loss of life. Any such use is entirely at your own risk, and you agree to hold LEPIDE SOFTWARE 
PRIVATE LIMITED harmless from any and all claims or losses relating to such unauthorized use.      

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts in the State of Delhi, and you consent to 
such jurisdiction and venue. There are no third party beneficiaries of any promises, obligations or 
representations made by LEPIDE SOFTWARE PRIVATE LIMITED herein. 

Any waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any violation of this License by you shall not 
constitute, nor contribute to, a waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any other or future 
violation of the same provision, or any other provision, of this License. 


